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1 Starting a Project 

1.1 Loading a new image sequence 
 

Menu:  File  →  new Image Sequence... 

 Symbol Shortkey 

Image Folder 
 

Ctrl+Alt+N 

Sequence File (*.seq) 
 

Ctrl+N 

 

A new image sequence can be loaded either by opening the folder containing the images or by using 

an ASCII file (*.seq) that specifies the path of the images and the specific image names to be 

processed as an image sequence. In the first case, all images in the folder are processed. In the 

second case, only the specifically defined images of a data folder are processed. 

 

1.2 Image Navigation/User Interface 
 

Tools to navigate through the image sequence: 

 Symbol Shortkey 

Show previous/next 
image in sequence  

Arrow keys 

Show specific image Choose from drop list 

 

Tools to navigate within an individual image: 

 Mouse action 

Zoom Scroll wheel 

Shift Keep left mouse key pressed 

 

While navigating through the image sequence, the selected zoom section of the image is retained. 
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1.3 Open, Save, Close Projects 
 

Menu:  File  

 Symbol Shortkey 

open Project 
 

Ctrl+O 

save Project --- Ctrl+S 

save Project as --- Ctrl+Alt+S 

close Project --- --- 

 

The current processing status when evaluating an image sequence can be saved in a project file 

(“ProjectName.emt”). A corresponding data folder ("ProjectName.source") is also created, which 

must always be in the same directory as the project file. By opening the *.emt file the project can be 

reloaded. 

A project will be closed when loading a new image sequence, opening another existing project or 

closing the application. 
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2 Preparing Image Sequences 
 

The Edit menu item contains tools that can be useful for preparing image sequences for processing. 

 

2.1 Distort or undistort images 
 

Menu:  Edit → Distort / Undistort images…  

This tool may be useful in case the cameras for DTM-

Generation and recording of image sequences have 

been pre-calibrated.  

All images available in the input folder are 

transformed to undistorted images by the calibration 

parameter given in the accordant camera file *.cam 

and saved in the specified output folder. 

So far the calibration models as implemented in the 

Software packages “Aicon 3D Studio” and “Agisoft 

MetaShape” are available. 

The used calibration model needs to be indicated in 

the camera file (see chapter 6.1.3). 

 

In reverse undistorted images can also be distorted. 

This may be necessary when depth images derived 

from an undistorted image bundle need to be 

adapted to the distorted image sequence. 

“OK” → Starts the image transformation 

 

2.2 Save or edit an image sequence file 
 

Menu:  Edit → Save/Edit image sequence file…    

The image sequence file *.seq allows to pick and combine images stored in a folder to form an 

individual image sequence (see chapter 6.1.1). 

This tool helps to automatically generate an image sequence file.  
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 Open an image sequence by selection the image folder or an already existing *.seq file. 

 

  Specify the current time interval between successive 

frames of the loaded image sequence. 

 To create an image sequence with a 24h time interval, 

select "Define by time" and set the time for which the 

24h sequence should be saved -> click on "Save 

sequence". 

 To create an image sequence with a specific time 

interval or if every e.g. second or tenth image is to be 

used, chose “define by interval” and set the interval and 

unit -> click “Save Sequence” 

 Specify name and memory location of the file to be 

generated. 

 

2.3 Remove dark images 
 

Menu:  Edit → Save/Edit image sequence file…    

Image sequences that were taken at hourly or minutely frame rates and contain night images or 

image sequences that are interrupted by fog and rain images may have to be pre-sorted before they 

can be processed. With this tool, dark or foggy images can be automatically sorted out according to 

the criteria of the mean grey value (for the identification of dark images) and the scattering of grey 

values around this mean value (for the identification of homogeneous texture as for foggy images). 

 Choose image folder to be sorted 

 Choose threshold for mean grey 

value -> images with a mean grey 

value below will be copied to a sub 

folder “SortedOut” created within 

the image folder  

 Choose threshold for standard 

deviation -> images with a standard 

deviation of its grey values below 

this threshold will be copied to a 

sub folder “SortedOut” created 

within the image folder. 

 click “Start” to begin image sorting.  

In the folder “SortedOut” a file “statistics.txt” is created that contains the calculated mean grey value 

and grey value standard deviation for each image and indicates if the image has been judged to be 

usable “1” or if it has been sorted out “0”.  
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3 Workflow 
 

3.1 Camera Motion Parameter 

The menu item "Camera Motion Parameter" comprises all steps for the co-registration of the individual 

images of a sequence to the start image of the sequence:  

1. Static points are defined which are not influenced by object movements (glacier movement, 

landslide motion) -> “Define fix points...".  

2. These fix points can be tracked to find the individual shifts between each sequence image and 

the start image -> “Track fix points...”.  

3. Affine transformation parameters are calculated from these vectors -> “Camera motion 

parameter...”.  

The determined affine transformation model will be automatically applied during object point 

tracking to correct the measurements. 

 

3.1.1 Define fix points 

Menu:   Workflow  →  Camera motion...  →  Define fix points... 

 Select "Single points" / "Delete single points" to set or delete individual points by clicking the 

right mouse button on the position or the point in the image. 

 Select "Raster points in polygon" to draw a polygon in the image using the right mouse 

button. To finish the polygon double-click the right mouse button. Chose the raster width of 

points the polygon shall be filled with and click “Apply” to display them.  

 It is possible to draw and individually fill several polygons. The polygon drawn last is 

displayed in red. This is the active one whose content can be edited.  

 To delete several points at once either define a polygon and click „Delete Points in Polygon", 

or click "Delete all Points" to completely clear the point selection. 

 A point selection can be saved as a text file “Save Points” or loaded from a text file “Load 

Points” 

  “OK” → Closes the dialog and accepts the displayed points to be used in the further working 

process 

 

 Fix points are displayed in green colour. 
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3.1.2 Track fix points 

Menu:   Workflow  →  Camera motion...   →  Track fix points... 

 Choose Tracking method: 

o Least squares matching (LSM):  directly obtained subpixel accuracy of results, 

accuracy estimation 

o Cross-correlation: fast, less robust than LSM, subpixel interpolation is realized by 

fitting a paraboloid into the neighbourhood correlation values of the maximum. The 

size of the neighbourhood can be varied. A value of "0" means no subpixel 

interpolation, a value of "1" means that the 8 direct neighbours of the correlation 

maximum are used for subpixel interpolation, a value of "2" means the 8 direct 

neighbours plus the 16 neighbours of the second row are used, etc. 

o Least squares matching with shadow removal: this LSM version includes a method 

for the detection of pixels affected by shadow motion. These pixels are excluded 

during the matching process, slower than LSM 

 

 Choose Tracking strategy: 

o Feature tracking - fix master image:  The first image of the image sequence is always 

used as master image. (This is the recommended method for fix point tracking)   

o Feature tracking - consecutive: A specific feature is tracked through the entire 

sequence, with the last slave image being used as the new master image for the next 

tracking step and the last found position as the new reference position for the 

tracking. (The method can be used for fix point tracking in case of strong illumination 

changes during a sequence but can lead to drift effects because errors may sum up 

unfavourably)  
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o Tracking at fix position: The reference position of the tracking points is equal for each 

master image. This means the measured translations represent the flow at a fix 

position in space (not supported for fix point tracking). 

o The master image increment and slave image increment can be chosen individually. 

The steps can be set by numbers of images or time intervals. Most flexibility exists in 

this respect when “Tracking at fix position” has been chosen as tracking strategy. 

Thus it is e.g. possible to track from every image of the loaded image sequence into 

an image acquired 24h later. 

 

 

Example:  Master image increment = 2 images and slave image increment = 3 images 

 

 

 

 

  

 

 Choose Tracking parameter: 

o Patch Size: Patch width and height in pixel 

o Search area: restricts the search area for the corresponding patch, individually 

definable (in pixels) for each coordinate direction. 

 

 After choosing parameters start the tracking by clicking “ok”. A dialog opens which shows the 

progress of the tracking.  

 

 The growing trajectories are displayed in the images during the tracking. Fix point 

trajectories are displayed in green colour. 

 

Img 1 Image sequence: Img 2 Img 3 Img 4 Img 5 Img 6 Img 7 Img 8 Img 9 

Image pairing during 

tracking: 

Example:   Master image increment = 2 images and slave image increment = 3 images 

 

Example:  Master image increment = 2 images and slave image increment = 3 images 

 

Masterimage 

increment 

Slave image 

increment 
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3.1.3 Camera Motion Parameter 

Menu:   Workflow  →  Camera motion...   →  Camera motion parameter... 

 Choose affine transformation parameter: 

o Transformation equations:  x2= a0+ a1x1+a2y1   ;    y2= b0 + b1y1 + b2x1    

o Each parameter can be enabled or disabled individually. If enabled the parameter 

will be estimated and the given value is used as start value for the estimation. If 

disabled the parameter is set fix and the given value is used as is. 

 

 Choose RANSAC parameter: 

o Iteration: maximum number of iterations allowed. 

o Model deviation: Maximum deviation of a measured value from the affine model to 

be used for parameter estimation. 

o Max Outlier: Specifies the maximum percentage of measurements (fixed point shifts) 

that are allowed to be skipped as outliers. 
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 “Calculate parameter” starts the estimation of an affine transformation between every 

image of a sequence and the first image.  

 

 The estimated parameters and statistical information are shown and can be exported via 

“Export”. 
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 After processing all images the measured vectors (red), the modelled vectors (green) and the 

remaining residuals (yellow) can be depicted (check boxes) and super elevated (slider) for 

each image.  

 

 Click “...previous” or “next...” to switch between images or choose an individual image by its 

index number and click “Set Image”. 

 

 OK" accepts the results, which will then be used for the camera movement correction during 

object point tracking and closes the dialog. 

 

Transformation Tools: 

Affine parameters that are calculated between the reference sequence image (to which the depth 

map refers and in which start points are defined) and another sequence image (which e.g. serves as 

the start image of a certain image sequence section) can be used to transform start points or the 

depth map into the new start image.  

 Transform start points: 

o Load start points 

o Calculate camera motion affine parameter 

o Click “ Start PointTrafo” 

o Select output directory 

 
 For each image pair the coordinates of all start points available (fix points as well as 

object points) will be transformed such that they refer to the same position in object 

space as in the master image 

 

 Transform a depth map: 

o Calculate camera motion affine parameter 

o Click “ Depth MapTrafo” 

o Select the depth map referring to the master image  

 
 For each image pair the depth map will be transformed such that it overlays the 

accordant slave image correctly. The transformed depth maps are saved in the same 

folder as the input depth map 

 

Affine parameters calculated for an image sequence can be used to transform each image of the 

sequence to fit the start image and thus eliminates the effect of camera motion and generates a 

camera motion free image sequence. 

 Transform images of an image sequence: 
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o Load image sequence 

o Calculate camera motion affine parameter 

o Click “ Sequence Image Trafo” 

o Select output directory 
 

 Each image of the sequence will be transformed to fit the start image and will be 

saved in the chosen output folder 

 

3.2 Object Point Motion 

The menu item "Object Point Motion" comprises all steps for the determination of the motion curve 

(trajectory) of object points and their scaling and georeferencing:  

1. Object points are defined within the dynamic area of interest -> “Define object points...".  

2. These points can be tracked to find the individual shifts between successive images (or specific 

image combinations) -> “Track object points...”.  

3. The determined shifts are scaled and assigned to a 3D position in space ->  

“Scaling/Georeferencing...”. 

 

3.2.1 Define object points 

Menu:   Workflow  →  Object motion...  →  Define object points... 

 Object points are selected and deleted analogue to fix points (see chapter 3.1.1) 

 

 Object points are displayed in red colour. 
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3.2.2 Track object points 

Menu:   Workflow  →  Object motions...   →  Track object points... 

 Tracking parameter choice:  see section 3.1.2. 

 

 After choosing parameters start the tracking by clicking “ok”. A dialog opens which shows the 

progress of the tracking. The display of trajectories can be enabled or disabled. 

 

 If camera movement parameters were determined before object point tracking, the camera 

movement corrections are automatically applied to the measured object point trajectories. 

 

 The display of trajectories can be enabled or disabled. If enabled, the growing trajectories are 

displayed in the images during the tracking. Measured object trajectories are displayed in red 

colour. Object trajectories that have been corrected for camera motion are displayed in 

yellow. 

 

 

 

 

3.2.3 Scaling/Georeferencing 

If object point trajectories are available, they can be scaled to a metric unit and assigned to a 3D 

position in space. For this purpose a depth map and camera orientation parameter are required.  

Menu:   Workflow  →  Object motions...   →  Scaling/Georeferencing... 

 Choose depth map: two file formats are supported:  
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o One option is to load a 32bit *.tif file which can e.g. be obtained from an (Agisoft) 

MetaShape project via Phyton script. 

o Another option is to load a *.dmap binary file (compare section 6.1.4) 

o The loaded depth map is shown overlaid on the sequence images 

 

 Choose camera file: This file need to be filled with different camera specific information 

before loading. For file structure and content see section 6.1.4) 

 

 “Transformation” starts the scaling and georeferencing. 

 

 Via “Export” it is now possible to save the trajectories in metrical units (compare section 5.3). 

 

 

 

Scaling via given plane 

For some applications it might be sufficient to scale trajectories by projecting the onto a predefined 

plane (e.g. tracking on water surfaces)  

 Choose camera file 

 Check “Motion within specific plane” 

 Define plane by its scalar equation 

 “Transformation” starts the scaling and georeferencing 
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4 Visualisation 

4.1 Trajectories 
 

Menu:   Visualisation  →  Trajectories 

 The display of trajectories can be enabled or disabled. Object trajectories as measured are 

displayed in red colour. Object trajectories corrected for camera motion are displayed in 

yellow. 

 

4.2 Velocities 
 

Menu:   Visualisation  →  Velocities 

If trajectories are available that have been scaled and georeferenced and if the images contain 

information about their recording time, velocity values can be calculated. 

 This tool enables the visual display of daily velocities. The display of the horizontal or vertical 

velocity component can be selected.  

 

 The sliders vmin and vmax can be used to adapt the scaling of the colour bar  

 Click “Optimize vmin/vmax” to automatically set an optimal colour scaling for the whole 

image sequence. 

 Click “Flip Colors” to get a reverse color depiction 

 

 The slider “Patch Size” changes the size of the dots referring to the positions of measured 

object points 

 The slider “Opacity” changes the opacity of the depicted dots 

 

 Click “Show Plot” to open a horizontal 2D-Plot to display the measured points and their 

determined velocity values in the world coordinate system defined during the geo-

referencing procedure. 
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5 Export 

5.1 Start Points 

Menu:   Export  →  Startpoints...    

 Exports the image coordinates of all existing start points. If both fix points and object points 

are available, two files will be created. 

 

5.2 Camera Motion parameter 

Menu:   Export  →  Camera Motion Parameter...    

 Exports the parameter of the affine transformation and statistic parameters of the 

adjustment. 

 

5.3 Trajectories 
 

Menu:   Export  →  Trajectories...    

 Output folder: Select the folder in which the exported files are to be saved. 

 

 Choose trajectory type: 

o Tracked Object Points: If no camera movement was determined during the workflow, 

the object point trajectories are exported as they were tracked (uncorrected). 

Otherwise, if the camera motion has been determined and was applied during the 

tracking corrected object point trajectories are exported. 

o Tracked Fix Points: Fix point trajectories are exported if available. 

 

 Choose file type: 

o Single Output File: The tracking results for the entire image sequence are exported to 

a single file. The data is stored imagepairwise. 

o Individual file for each image pair: Tracking results are exported separately to a single 

file for each image pair.  

o  Individual file for each trajectory: Tracking results are exported separately to a single 

file for each tracked point. 

 

 Output attributes: Select/Deselect the type of coordinates, statistic data or other attributes 

that should be content of the export files. 

 

  Click “Export” to start saving the files. 
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5.4 Trajectories 
 

Menu:   Export  →  Tracking Report… 

  Exports the settings for the most recent tracking of fix points and object points as well as the 

meaning of the tracking error codes. 
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6 Data Formats 

6.1 Input 

6.1.1 Image sequence file (*.seq) 

 

           

 

6.1.2 Start point file (*.dat) 

 

 

 

6.1.3 Camera file (*.cam) 

 

The camera file consists of 4 different sections of camera information which is required in the scaling 

and georeferencing process: 

1. Section - camera: Contains information about the cameras sensor size and image resolution 
 

2. Section - calibration parameter: Specifies the interior orientation of the camera. Currently 
the calibration model described in Luhmann et.al. (2006) is supported which is e.g. integrated 
in the calibration and 3D measurement software Aicon 3D Studio (Aicon 3D Systems) and the 
calibration model as implemented in Agisoft Metashape (Version 1.5.1). A strategy for using 
non-supported calibration types would be to undistort all sequence images (and the depth 
map) and set the distortion parameters to zero. 
 

3. Section – exterior orientation: Contains information about the position (X Y Z) of the 
sequence camera and its orientation in form of a rotation matrix (referring to the sequence 
reference image). Currently a rotation matrix is supported as it is implemented in Metashape 
(Agisoft). When exporting exterior camera information with Metashape via File -> Export -> 

D:\Data\ImageSequence 

SeqImgName_01.JPG 

SeqImgName_02.JPG 

SeqImgName_03.JPG 

SeqImgName_04.JPG 

SeqImgName_05.JPG 

SeqImgName_06.JPG 

SeqImgName_07.JPG 

SeqImgName_08.JPG 

SeqImgName_09.JPG 

SeqImgName_10.JPG 

Path of image folder 

Listed file names of images 

building a sequence 

549.250   2712.216   

589.250   2692.216   

609.250   2732.216   

629.250   2772.216   

649.250   2672.216   

669.250   2752.216  

709.250   2692.216          

         

Listed image coordinates (x y) of 

start points 
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Cameras and choosing the “omega phi kappa” file type the exported file contains the 
position and rotation matrix of the sequence camera which can be used for the *.cam file. 
 

4. Section – object flow direction: Since the approach is designed for the use of a single 
sequence camera, the georeferencing requires a vector for the objects flow direction in case 
the flow direction is not orthogonal to the cameras viewing direction. If all values are set to 
zero, orthogonality between flow direction and camera viewing direction is assumed. 
 

Example for *.cam file using the “Metashape” – calibration model: 

 

 

 
 
 

 

#------------------------------------------------------------------------ 

# camera: 

#------------------------------------------------------------------------ 

Type: CameraName_18mm 

 

# sensor size: 

# width [mm] height[mm] 

22.23135072  14.82090048 

 

# image resolution: 

# width [pixel] height[pixel] 

  3888   2592  

 

#------------------------------------------------------------------------ 

# calibration parameter: 

#------------------------------------------------------------------------ 

Type: MetaShape 

 

# principle distance and coordinates of principle point:  

# c[pixel]  xh[pixel]  yh[pixel] 

4312.77497146208  -98.9776093891651   25.1770805938547 

 

 

# parameter of distortion polynomial:  

#  K1   K2   K3   K4   P1   P2   P3   P4   B1   B2  

 -0.1618074 0.0816965 0.2143089 -0.1513396 -0.0064308 -0.0008692 -2.6985223 5.2942891 8.79723522 14.2201625 

 

#------------------------------------------------------------------------ 

# exterior orientation: 

#------------------------------------------------------------------------ 

Type: MetaShape 

 

# file name sequence reference image 

SequenceImage.JPG  

 

# position:  

# X[m]    Y[m]    Z[m] 

632563.371329805 -5228382.0346393958 537.27662612977963 

   

# rotation matrix:  

# r11  r12  r13   

# r21  r22  r23   

# r31  r32  r33 

-0.2262046218554097  0.9736994879199304  0.0272172055089511  

-0.0757425169106097 -0.0454392099441785  0.9960915366228622  

 0.9711305474462726  0.2232590097266275  0.0840290092324586 

 

#------------------------------------------------------------------------ 

# object flow direction: 

#------------------------------------------------------------------------ 

# X1[m]      Y1[m]       X2[m]       Y2[m] 

630340.24  4771696.96   631783.04  4769890.78 
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When using the “Aicon” – calibration model the calibration parameter text block needs to be written 
as in the following example: 

 

 

6.1.4 Depth map (*.dmap) 

A binary file containing depth values for each pixel of the sequence image. 

Structure:  

- 2 x int (32 bit) (image width, image height) 

- 6 x double (64 bit) (Parameter of affine transformation: a0  a1  a2  b0  b1  b2 -> should be zero if 

depth map refers to sequence reference image) 

- number of pixels x double (64 bit) (distance to object point in m) 

 

 

6.2 Output 

6.2.1 Start points (*.dat) 

Compare section 6.1.2 

 

6.2.2 Camera motion parameter (*.dat) 

 

 

 

 

#------------------------------------------------------------------------ 

# calibration parameter:  

#------------------------------------------------------------------------ 

Type: Aicon 

 

# principle distance and coordinates of principle point:  

# c[mm]  xh[mm]  yh[mm] 

19.92169  -0.14059  -0.00174 

 

# parameter of distortion polynomial:  

#  A1   A2   A3   B1   B2   C1   C2   r0 

-3.5806e-004  1.0784e-006  -1.0473e-009  -2.2300e-004  5.1167e-005  -1.8806e-003   6.3042e-003  0.00000    

 

image pair   s0[pix]  MaxModelDev  Iter. UsedPoints       a0        a1       a2         b0        b1        b2 

 0 ->   1     0.18        1.0       2       94.1%     -0.85481   1.00001  -0.00008   -0.97167   1.00000   0.00022 

 0 ->   2     0.28        1.0       2       84.1%     -0.59941   1.00002  -0.00027   -1.79943   1.00001   0.00048 

 0 ->   3     0.44        1.3       2       73.6%      0.05196   0.99999  -0.00062   -2.87049   0.99986   0.00071 

 0 ->   4     0.27        1.0       2       86.7%      0.11051   0.99999  -0.00074   -5.17553   0.99995   0.00112 

 0 ->   5     0.26        1.0       2       89.7%      0.11835   1.00009  -0.00088   -5.75845   0.99992   0.00146 

 0 ->   6     0.47        1.3       2       71.0%      0.87335   0.99996  -0.00115   -7.84454   0.99990   0.00169 

 0 ->   7     0.45        1.3       2       76.5%      1.31294   0.99996  -0.00143   -7.62779   0.99965   0.00178 

 0 ->   8     0.35        1.1       2       76.9%      1.03371   1.00010  -0.00147   -8.49468   0.99980   0.00198 

 0 ->   9     0.31        1.0       2       85.7%      0.99546   1.00007  -0.00132   -9.30110   0.99991   0.00214 

 0 ->  10     0.31        1.0       2       80.1%      0.76288   1.00006  -0.00135  -10.13480   0.99989   0.00224 

 0 ->  11     0.52        1.5       2       78.3%      1.10227   0.99990  -0.00169  -10.04016   0.99983   0.00219 

 0 ->  12     0.41        1.2       2       76.2%     -0.03584   1.00010  -0.00130  -10.13238   0.99987   0.00223 

 0 ->  13     0.29        1.0       2       72.8%      1.00305   1.00010  -0.00222  -10.51602   1.00018   0.00225 

 0 ->  14     0.30        1.0       2       86.1%     -0.30569   1.00016  -0.00125  -10.14009   0.99989   0.00228 
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6.2.3 Trajectories (*.dat) 

Single Output File: 

 

Individual file for each image pair:  

- Start point file: 

 

tracking method:  least squares matching   

tracking strategy:  tracking at fix position   

number of image pairs:       22  

number of tracked points:  1187  

 

----------------------------------------------------------------------------------- 

coordinates of trajectory start points: 

----------------------------------------------------------------------------------- 

 

   Trajectory ID     X[m]         Y[m]         Z[m]            x[pix]      y[pix]          

         1       631497.808  -5228704.213     469.928         1687.051    1207.775        

         2       631409.070  -5228724.239     478.422         1707.051    1167.775        

         3       631432.589  -5228717.066     472.857         1707.051    1187.775 

         4       631492.834  -5228699.026     469.880         1707.051    1207.775 

 … 
----------------------------------------------------------------------------------- 

tracking results: 

----------------------------------------------------------------------------------- 

 

                   index        aquisition time           file name 

master image:        0          08.02.2013 10:22:51       Image01.JPG 

slave image:         1          08.02.2013 10:42:51       Image02.JPG 

 

time intervall: 1200 sec 

 

Trajectory ID  dX[m]  dY[m]  dZ[m]   dx[pix] dy[pix]  sdx[pix] sdy[pix]  s0 LSM [grey value] CC_Coeff  v [m/d]              

      1       -0.083  0.083 -0.010   0.123   0.033    0.03088  0.01412         5.3             0.73    0.11746        

      2       -0.072  0.072 -0.010   0.112   0.034    0.02037  0.00882         2.9             0.91    0.10188        

      3        0.069 -0.069 -0.021  -0.104   0.026    0.02016  0.00954         3.1             0.91    0.09789        

      4        0.079 -0.079 -0.047  -0.117   0.079    0.01960  0.00954         3.1             0.87    0.11144 

… 
----------------------------------------------------------------------------------- 

 

                   index        aquisition time           file name 

master image:        1          08.02.2013 11:02:51       Image02.JPG 

slave image:         2          08.02.2013 11:22:51       Image03.JPG 

 

time intervall: 1200 sec 

 

Trajectory ID  dX[m]  dY[m]  dZ[m]   dx[pix] dy[pix]  sdx[pix] sdy[pix]  s0 LSM [grey value] CC_Coeff  v [m/d]              

      1       -0.083  0.083 -0.010   0.123   0.033    0.03088  0.01412         5.3             0.73    0.11746        

      2       -0.072  0.072 -0.010   0.112   0.034    0.02037  0.00882         2.9             0.91    0.10188        

      3        0.069 -0.069 -0.021  -0.104   0.026    0.02016  0.00954         3.1             0.91    0.09789        

      4        0.079 -0.079 -0.047  -0.117   0.079    0.01960  0.00954         3.1             0.87    0.11144 

… 
 

tracking method:  least squares matching   

tracking strategy:  tracking at fix position   

number of image pairs:       29  

number of tracked points:  6192  

 

   Trajectory ID     X[m]         Y[m]         Z[m]            x[pix]      y[pix]          

         1       602926.956  6738296.200    1670.548           31.348    1065.982        

         2       602900.971  6738390.353    1669.158           31.348    1090.982        

         3       602878.166  6738473.216    1667.411           31.348    1115.982        

         4       602857.812  6738547.351    1665.459           31.348    1140.982        

         5       602840.300  6738611.494    1662.947           31.348    1165.982        

         6       602821.696  6738679.041    1661.766           31.348    1190.982        

         7       602804.711  6738740.802    1660.498           31.348    1215.982 

… 

 



 

 

 

 

 
     24 

 
  

 

- Image pair file: 

 

 

 Individual file for each trajectory: 

- Tracking Info file: 

 

- Trajectory  file: 
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                   index        aquisition time           file name 

master image:        0          27.07.2015 12:01:09       SeqImgName_01.JPG 

slave image:         1          28.07.2015 12:01:11       SeqImgName_02.JPG 

 

time intervall: 86402 sec 

 

Trajectory ID  dX[m]  dY[m]  dZ[m]   dx[pix] dy[pix]  sdx[pix] sdy[pix]  s0 LSM [grey value] CC_Coeff  v [m/d]              

      1       -0.083  0.083 -0.010   0.123   0.033    0.03088  0.01412         5.3             0.73    0.11746        

      2       -0.072  0.072 -0.010   0.112   0.034    0.02037  0.00882         2.9             0.91    0.10188        

      3        0.069 -0.069 -0.021  -0.104   0.026    0.02016  0.00954         3.1             0.91    0.09789        

      4        0.079 -0.079 -0.047  -0.117   0.079    0.01960  0.00954         3.1             0.87    0.11144 

      … 

 

tracking method:  least squares matching   

tracking strategy:  tracking at fix position   

number of image pairs:    2033616  

number of tracked points: 2031616 

Trajectory ID        X[m]         Y[m]         Z[m]            x[pix]      y[pix]          

        1        631497.808  -5228704.213     469.928         1687.051    1207.775        

 

ID master ID slave  dX[m]  dY[m]  dZ[m]  dx[pix] dy[pix] sdx[pix] sdy[pix] s0LSM  CC_Coeff  dt[sec] v[m/d]       

    0         1    -0.032  0.041  0.036  0.155   -0.114  0.00520  0.00506   1.6     0.98    1200    3.74701        

    1         2    -0.012  0.015 -0.014  0.054    0.043  0.00613  0.00596   1.6     0.97    1200    1.37066        

    2         3    -0.002  0.002  0.024  0.010   -0.075  0.00672  0.00665   1.8     0.97    1200    0.18458   

      … 

 


